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Test Series Microsoft Word

Module 9 - Adding and Editing Shapes in MS Word

(o] :3Y I Definition

The Insert Menu in MS Word is a feature that allows users to add various
elements such as tables, images, charts, text boxes, and other objects into a
document. This menu helps enhance the document's structure, readability, and

visual appeal.
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L O Use of Shapes in MS Word
We use Shapes in MS Word to make documents
_ more visually appealing, organized, and easy
to understand. Here are some key reasons '
o (o] : 5y W why shapes are used: f\ .
et To Enhance Presentation
I:I » Shapes like arrows, boxes, and circles can 9
¢ highlight important points in a document. II# (\ )
A |CSE ¢ Used for decorative elements to improve D -
o/ e document design.
To Create Diagrams & Flowcharts
_ e Shapes help in creating organizational
charts,
e process diagrams, and workflows.
e Useful for business documents, educational
_ e materials, and technical reports.
T 'i:?ﬂ:ﬂc&e Add Text in a Shape
Step-by-Step Guide:
_ Insert a Shape: u. s
e Open MS Word and go to the Insert tab. ’ s
e Click on Shapes (in the Illustrations group).
LA « Choose a shape and draw it in your document.
I:I Add Text to the Shape: o
e Right-click on the shape. _— :
o PPN ° Select Add Text (or Edit Text). ;. I
SR @ A cursor will appear inside the shape. G
Type Your Text: =
I:I e Start typing, and the text will appear inside:the = i |
Shape. Grouping b
.o LAW .
s Eﬂtrﬂnce Set AutoShape Defaults
I:I & Format AutaShape/Picture
B Lnk
1 New Comment
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: Rotate a Shape in MS Word
Test Series You can rotate a shape in MS Word using
the following methods: 5
Method 1: Using the Rotate Handle (Quick
Method)
Insert a Shape:
¢ Go to the Insert tab — Click Shapes —
Select and draw a shape.
Rotate the Shape:
o Click on the shape to select it.
o A circular arrow (&) appears at the top
of the shape.
« Click and drag this handle left or right to rotate the shape freely.
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@ N1 Helping Tool of Shapes

The Format Menu in MS Word provides tools to customize the appearance of text,
images, shapes, and other elements in a document. It helps improve readability,
design, and overall presentation.
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Edit Shape in MS Word
The "Edit Shape” feature in MS Word allows users to | |§ Edit Shape =
modify an existing shape by changing its form,
m MITENCTR o djusting its points, or converting it into another @
Services shape. This is useful for customizing diagrams,
flowcharts, and creative designs.

Change Shape b

< Edil Puinls

E ﬁ.u Reroute Connector:

++ LAW Reroute Connectors
o ST A connector is a line that links two shapes. Unlike a normal line, a connector
stays attached to the shapes even if you move them.

Reroute Connectors automatically change the connector’s path to avoid
MBA overlaps or create the shortest path between shapes.

LU This is especially useful in flowcharts, diagrams, and organizational charts where

connectors need to avoid overlapping or tangled paths.

LD How to Use Reroute Connectors

=" Services 1. Insert Shapes

1. Go to Insert — Shapes — New Drawing Canvas.
«~Mmany moreg 2. Select a shape (e.g., Rectangle, Oval).
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T Shape Styles in MS Word oooDoGcoD
Shape Styles in MS Word are predefined formatting o R R N

options that allow users to customize the appearance _ P —
LA of shapes, such as rectangles, circles, and-arrows. (=d A 88 -
= Entruvn’ce s . a a .
= Shape Fill in MS Word 0 CcoD o

Shape Fill in MS Word lets you add color, gradient,

MBA
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3. Draw two or more shapes on your slide/document.

2. Add Text to Shapes

1. Right-click a shape.

2. Choose Add Text.

3. Type your desired label (e.g., "Start” and "End").

3. Connect Shapes

1. Go to Insert — Shapes and select a Connector (like Elbow Connector or

Straight Connector).

2. Hover over the first shape until you see connection points (small dots).
3. Click a connection point on the first shape, then drag to a connection point

on the second shape.

4. Reroute the Connector

« If you move the shapes, the
connector may twist awkwardly.

e To fix it:

1. Select the connector line.

2. Right-click and choose Reroute
Connector.

3. The connector will automatically
adjust to take a cleaner or shorter
path.

Reroute Connector

NOTE: This is especially useful in flowcharts and diagrams to-keep them neat.

texture, or pattern to a shape’s interior for

customization. It offers various options to enhance the visual appearance of

shapes and make them more dynamic in your document.
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: Gradient - Shape Fill
Test Series A Gradient in MS Word is a color effect that blends |
two or more colors smoothly within a shape. It e
enhances the visual appeal of shapes, making them
more attractive and professional.
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More Gradient - Shape Fill
"More Gradients” in MS Word

= allows you to create custom Fill Effects ¢ x
— Banking & gradient fills for shapes, text, or

Insurance backgrounds. It offers advanced Trsure | Poftem | Rche
. . . . Colors
_ options to adjust colors, direction, O o cotor
and transparency for a ) Twa colors
L personalized gradient effect. ) Preget
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799 Shape Outline = shap=Outiine~| | —
Test Series In Microsoft Word, a shape outline refers to the border | - _ . _ —
or the edge of a shape, such as a rectangle, circle, or - o - -
_ any other shape inserted into the document. The u
outline helps define the boundaries of the shape and e
| NN ]

can be customized in terms of color, thickness, style, EEEEEEE=EEE

CBSE

and other visual properties.
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' = Weight .
[zz] «Pattern...
_ Shape EffeCtS <3 shape Fill =
In Microsoft Word, Shape Effects are special visual e SEe Zausmes = 4

— Shape Effeckts *!

—_ Banking & enhancements that can be applied to shapes, such as —
PEITETTT R text boxes, autoshapes, or drawn objects. These effects | ——

can make your shapes stand out and improve the overall | | | sracow -

design of your document. Gl
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i s"g:fv&:s" i WordArt Styles
WordArt Styles in Microsoft Word are pre-designed text effects that let you
create decorative and visually appealing text.

These styles include: A £
s e Text Fill - Allows you to fill the text with A A _f,/x—yx A A

|

>
=

= Entrance PN colors, gradients, textures, or pictures.
e Text Outline - Adds a border around the text '/,’E,\\ A /j
A\ \

with different colors and thicknesses.
M e Text Effects - Applies effects like shadows,
NI reflections, glows, 3D rotation, and bevels. /E\ A A A
e Transform - Lets you bend, stretch, or shape I\ ,
the text into different forms (e.g., wavy,
circular).
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Test Series

Text Fill A [Text Fill - | || Text Dird
. Automatic

Text Fill is a formatting feature in Microsoft Word that
allows you to change the color, gradient, texture, or even
use an image inside the text. It is commonly used in
WordArt to create decorative text.

Theme Colors
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Standard Colors
HE EEEEN
Mo Fill
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280 More Fill Colars...
|] Gradient L4

&7 Text Outline - || [ Align Te

L LU Text Outline W itomatic
nsurance

Theme Colors

Text Outline is a feature in Microsoft Word that allows HE EEENEER
you to add a border or stroke around text. It is commonly
T KT A used in WordArt to make text stand out with different

ervice colors, thicknesses, and styles. . I n I I I I I I I

Standard Colors
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I:I Text Effects
Shadow »
EMBA Text effects in MS Word enhance text with visual styles such cetiection »
LLUELCLEEN as shadows, glows, reflections, and 3D effects. These -
effects help make text stand out and improve its visual - i
appeal in documents. B
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Test Series

Text Direction =] Align Text =
_ Text Direction in Microsoft Word allows you to change the — T
orientation of text in tables, text boxes, and shapes. You LOF
o CBSE can rotate the text vertically, horizontally, or at an angle.
R4
I:I Align Text i—— || Middle
f , |CSE Text Alignment in Microsoft Word allows you to position
e text horizontally and vertically within a document, table,
_ text box, or shape. .| Bottom
_ Create Link .
You can add a hyperlink to text inside a text Text in the
— Banking & box in Microsoft Word to link to a website, first shape
UL email, another document, or a specific section Flow of text
_ within the same document. \d
inki i i i Second
Contral Govt. Linking Shapes with Flowing Text in Word
ervice shape
Step 1 - Insert the First Shape
1. Go to Insert — Shapes.
2. Pick a shape (e.g., Rectangle, Rounded ]
m State Govt. Rectangle, or any closed shape). Third
LLMCCIIN 3. Draw the shape on your page. shape
4. Right-click — Add Text (or just start
typing).

ss _LAW

N T Step 2 - Insert the Second and Third Shapes
1. Repeat the same steps to insert two more shapes anywhere in the document.
2. Add placeholder text if you like, or leave them empty for now.

Step 3 - Link the Shapes Together

UL 17 Click inside the first shape to select it.

2. On the Shape Format tab (appears when the shape is selected), find the
Create Link button in the Text group.

T Y iz o In some versions of Word, you may need to go to Drawing Tools — Format to
=" Services IS

3. Click Create Link — the cursor changes to a pitcher icon.

..many morefl 4. Click inside the second shape.
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. 5. Repeat the process:
Test Series o Select the second shape.
o Click Create Link.
o Click inside the third shape.

How It Works

« If the first shape’s text overflows, the extra text flows automatically into the
second shape, then into the third.

» Resize or move shapes freely — the links still work.

» Change colors and outlines via Shape Format — Shape Fill / Outline.
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Position
In Microsoft Word, you can control the position of text, _ - _
text boxes, images, and other objects to create a well- [E S8 W Bing Fonsard

organized document layout. B vop ' Send Backward
- | Text~- %Selection Pane

|| In Line with Text

L=l
= Bllll'lkil'lg & With Text Wrapping
nsurance = = B
Central Govt. = a 4
Service

EI More Layout Options...

State Govt.
m P Wrap Text

Wrap Text in Microsoft Word controls how text flows
around images, text boxes, tables, and other.objects. This = ] ]
feature helps position objects more flexibly within a Wrap | Bring Send S

WE=D
~

|

>
=

A A document. 'I'jtv Farward ~ Backward ~
= Entrance A-  |nLinewith Text

Sguare

Tight

Through

MBA

Entrance

Tep and Bottem
Behind Text
In Front of Text

Edit Wrap Points
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Fix Position on Page

More Layout Options...
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: Bring Forward
Test Series The "Bring Forward" option in Microsoft Word is used
to move objects (such as images, text boxes, shapes, L}] Bring Forward
or WordArt) to the front of the document layout,
placing them above other elements. LJ] Ering Farward

| Align-

{,]] Ering to Front
f:} Bring in Fron: of Ted
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Send Backward

The "Send Backward" option in Microsoft Word is used to
move objects (such as images, text boxes, shapes, or
o)) WordArt) behind other elements in a document. This

&

(9 NTSE helps organize overlapping objects.

Send Backward| =

IR
Vi
H L

L:: Send Backward
2y sendto Back
=h sendBehind Text

— BUI‘IkiI‘Ig & Selection Pane Selection and Wisibility -~
S LI The Selection Pane in MS Word allows you to view, - =i

select, and organize objects such as shapes, text

boxes, and images in your document. It provides a

simple way to hide, show, or reorder objects for

better document management.

Central 'Govt.
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Group in MS Word

The Group feature in Microsoft Word allows you to
combine multiple objects (such as images, text
boxes, shapes, or WordArt) into a single unit. This
makes it easier to move, resize, or format them.

i State Govt.

Services

|

W ¥\ A Rotate in MS Word — et
= Entrance [PVR Word, the "Rotate” feature lets you turn
shapes or objects to any angle, either manually or by [« poiio. ey 4037
using preset options like 90-degree rotations. This " o
MBA helps adjust the orientation of shapes to fit your b Rotate Right 50
NI document's design. A FRotate Left 90°
= Flip Vertical
Ahgn n MS Word d Flip Horizontal
. In MS Word, the "Align" feature allows you to position
Railways & Metro ’ : -
= se:yices shapes relative to each other or the page, ensuring H  More Rotation Options...

they are evenly spaced and organized.
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T ri Height and Width
est Series In Microsoft Word, you can adjust the height and width of images, text boxes,
shapes, tables, and other objects to ensure they fit properly in your document.

Make this Assignment using Shapes in MS Word
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